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ABSTRACT
The bq27220 includes one-time programmable (OTP) profiles that allow users to program the settings that
would otherwise be required to be initialized in RAM after powering up. Calibration data is one of the
included subsets of data that can be programmed in to OTP. This guide goes over the process on how to
calibrate the bq27220 using the provided TI tools and how to transfer that to OTP.
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1 Tools Required for Calibration
The following tools are required for calibration:
• bq27220EVM with EV2400
• 2x power supplies, one for powering the gauge; another, for the OTP programming voltage.
• DC load capable of at least 1 A.
• bqStudio (minimum v1.3.51)
• SmartFlash

2 Operation
This section details the operation of the bq27220 bqStudio software.
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2.1 Starting the Program
With the EV2300 or EV2400 and the bq27220EVM connected to the computer, run bqStudio from the
desktop or installation directory. The window consists of a tools panel at the top, and other child windows
that can be hidden, docked in various positions, or allowed to float as separate windows. When bqStudio
first starts up, the DashBoard, the Registers, and the Commands windows should be open. Additional
windows can be added by clicking the corresponding icons in the tools panel at the top of the main
window.

The Scan (continuous scan) or Refresh (single time scan) buttons can be clicked in order to update the
data in the Registers and Data Memory windows.

bqStudio provides a logging function which logs selected Data Registers last received from the bq27220.
To enable this function, click the Start Log button. The default elapsed interval is 4000 milliseconds, to
change this interval, go to Windows, select Preferences, choose Registers, and change Scan/Log Interval
from 4000 to 1000 milliseconds. There is no need to log faster than 1 second as the gauge will not update
the registers faster than 1 second.

Figure 1. Registers Screen

2.2 Setting Programmable bq27220 Options
The bq27220 comes configured per the default settings detailed in the bq27220 Technical Reference
Manual (TRM – SLUUBD4) . Ensure that the settings are correctly changed to match pack and application
for the bq27220 solution being evaluated.

NOTE: The correct setting of these options is essential to get the best performance. The settings
can be configured using the Data Memory window (Figure 2).

http://www.ti.com
http://www.go-dsp.com/forms/techdoc/doc_feedback.htm?litnum=SLUA771
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Figure 2. Data Memory Screen

To read all the data from the bq27220 RAM, OTP, and non-volatile memory, click on the Read All button
on the Data Memory window. Make sure the device is not sealed and in full access to read/write to the
data memory. To update a parameter in RAM, click on the desired parameter and a window will pop-up
that provides details on the selected parameter. Next, enter the value in the value textbox and press
Enter. After Enter has been pressed, bqStudio will update the selected parameter.

See the TRM (SLUUBD4) for details on how to program the OTP values on the bq27220.

The Import button in the Data Memory window can be clicked in order to import an entire configuration
from a specified *.gg.csv file.

The configuration can be saved to a file by clicking the Export button in the Data Memory window and
entering a file name. The configuration will be saved to a *.gg.csv file. The module calibration data is also
held in the bq27220 data memory. If the Gauge Dashboard is not displaying any information, then the
bq27220 may not be supported by the bqStudio version that is being used, a bqStudio upgrade may be
required.

3 Calibration Process
The process to calibrate and program the OTP on the bq27220 is as follows:
1. Connect the bq27220 to bqStudio using the EV2400.
2. Perform the calibration storing the calibration data in RAM.
3. Use bqStudio to generate the ot.fs file required for OTP programming.
4. Use SmartFlash to program the OTP profile on the gauge.

See the following sections detailing the steps.

http://www.ti.com
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3.1 Calibration
The bq27220 must be calibrated to ensure accurate value reporting. This can be done by going to the
Calibration window in bqStudio.

Figure 3. Calibration Screen

NOTE: Please ensure the gauge is unsealed and in full access before proceeding with the
calibration procedure. See the TRM for details on how to unseal and place the gauge in full
access.

Calibration consists of the following:
• CC Offset/Board Offset: Simply check Calibrate CC Offset and Calibrate Board Offset and click

Calibrate Gas Gauge to calibrate the Coulomb counter and board offsets. Ensure no current is flowing
through the sense resistor during these steps. After a successful calibration, a green check mark
shows next to the Calibrate Gas Gauge button.

• Current: Connect a 2-A load to LOAD+/LOAD– or a current source to LOAD–/PACK–. Ensure the
measured current reported is negative, or else reverse the connections. Check Calibrate Current and
enter the current into the textbox followed by Calibrate Gas Gauge.

• Voltage: Apply a known DC voltage to PACK+/PACK– with no current flowing through the sense
resistor. Check Calibrate Voltage and enter the voltage into the textbox followed by Calibrate Gas
Gauge.

Once these steps are completed, program the design parameters for the application in RAM. Once both
the design and calibration parameters are verified, the ot.fs file can be generated. This file is used to
program the OTP profile by using SmartFlash.

The OTP profile must be programmed in its entirety using the ot.fs. In order to avoid programming
incorrect values, validate the configuration files before programming the OTP, for example, test out the
values in RAM and ensure performance is acceptable before proceeding with writing to OTP.

http://www.ti.com
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4 OTP Mode FlashStream (ot.fs) Files
The Battery Management Studio (bqStudio) software allows generation of specific instruction files (ot.fs
files), containing the necessary I2C commands a host can send to the bq27220 device to program the
RAM-based data memory parameters. The commands in these files are largely ROM commands only
used when the gauge is in CONFIG_UPDATE mode.

The ot.fs file is an ASCII text file containing commands and data. Each line of the file represents one
command and potentially 96 bytes of data, as described in the following text. No row contains more than
96 data bytes. The first two characters of each row represent the command, followed by a ":

"W:" — Indicates that the row is a command to write one or more bytes of data.
"C:" — Indicates that the row is a command to read and compare one or more bytes of data.
"X:" — Indicates that the row is a command to wait a given number of milliseconds before proceeding.

White space is used to separate fields within the ot.fs files. Each row contains only one of the four
commands. The commands discussed in this section can be implemented by a system that can perform
multi-byte or single-byte operations for I2C.

Figure 4 shows a typical ot.fs file snippet generated from the bqStudio software.

Figure 4. Typical ot.fs File Snippet

4.1 Write Command
The write command "W:" instructs the I2C master to write one or more bytes to a given I2C address and
given register address. The I2C address format used throughout this document is based on an 8-bit
representation of the address. The format of this sequence is:
"W: I2CAddr RegAddr Byte0 Byte1 Byte2…"

For example, the following:

http://www.ti.com
http://www.go-dsp.com/forms/techdoc/doc_feedback.htm?litnum=SLUA771
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W: AA 55 AB CD EF 00

indicates that the I2C master writes the byte sequence 0xAB 0xCD 0xEF 0x00 to register 0x55 of the
device addressed at 0xAA.

More precisely, it indicates to write the following data to the device address 0xAA:

0xAB to register 0x55

0xCD to register 0x56

0xEF to register 0x57

0x00 to register 0x58

4.2 Read and Compare Command
The read and compare command is formatted identically to the write command. The data presented with
this command matches the data read exactly, or the operation should cease with an error indication. The
ot.fs file contains no information about program flow or decision making. If a read and compare command
results in data which does not match the expected values, the interpreting program needs to handle the
next step itself. It should not continue with further commands but would typically go back to the beginning
of the ot.fs file and try again several times before giving up.

The format of this sequence is:
"C: i2cAddr RegAddr Byte0 Byte1 Byte2"

An example of this command is as follows:
C: AA 55 AB CD EF 00

This example expects the master to read back 4 bytes from the register address 0x55 of the device
addressed at 0xAA and then compare the data to the values given on the line command in this same
order as 0xAB, 0xCD, 0xEF, and 0x00.

4.3 Wait Command
The wait command indicates the host waits a minimum of the given number of milliseconds before
continuing to the next row of the FlashStream file. A wait command is typically used to allow the fuel
gauge processor to complete a process before proceeding to the next command in the file.

For example, the following:
X: 200

indicates that the I2C master must wait at least 200 ms before continuing.

4.4 CONFIG UPDATE Mode
If the application requires different configuration data for the fuel gauge, the system processor can update
RAM-based data memory parameters using the Control()SET_CFGUPDATE subcommand to enter the
CONFIG UPDATE mode.

NOTE: To ensure that the fuel gauge has entered CONFIG UPDATE mode correctly, there must be
at least an 1100-ms delay after sending the SET_CFGUPDATE. Operation in this mode is
indicated by the Flags()[CFGUPMODE] status bit.

In this mode, fuel gauging is suspended while the host uses the extended data commands to modify the
configuration data blocks. To resume fuel gauging, the host must send a Control()SOFT_RESET
subcommand to exit the CONFIG UPDATE mode, which clears both Flags()[ITPOR] and [CFGUPMODE]
bits. After a timeout of approximately 240 seconds (4 minutes), the gauge automatically exits the CONFIG
UPDATE mode if it has not received a SOFT_RESET subcommand from the host.

http://www.ti.com
http://www.go-dsp.com/forms/techdoc/doc_feedback.htm?litnum=SLUA771
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The memory of the bq27220 device is separated into memory subclasses defined in this document. The
memory cannot be directly addressed, but is updated through a sequence of extended commands that
can access each block of memory indirectly. The ot.fs file updates these blocks to write the proper
configuration so the bq27220 device can have proper gauging performance and match the system
characteristics. These updates are stored in RAM and need to be reprogrammed any time the device
loses power. (The [ITPOR] bit in the Flags() register indicates that the RAM configuration has been reset
to the defaults and is in need of updating using the ot.fs file.)

4.5 Programming Instructions

4.5.1 Using ot.fs Files
The following list shows how to use ot.fs files to configure the bq27220 device on power up:
1. Use the GPCCEDV tool (on ti.com) to generate the 7-point CEDV parameter and the 11-point loaded

voltage points, see the bq27220EVM-744 User's Guide (SLUUBF5).
2. Use the Battery Management Studio (bqStudio) software to finalize all the values for Calibration,

Configuration, or Gas Gauging in RAM based on the application.
3. Complete the following OTP profiles:

(a) Programming the OTP Profile 1
(i) Fill out the CEDV Profile 1 section in RAM with required values.
(ii) Write CEDV Profile Select → Battery ID to 4.

(b) Programming the OTP Profile 2
(i) Fill out the CEDV Profile 1 section in RAM with required values.
(ii) Write CEDV Profile Select → Battery ID to 8.

(c) Programming the OTP Profile 3
(i) Fill out the CEDV Profile 1 section in RAM with required values.
(ii) Write CEDV Profile Select → Battery ID to 16.

4. Use bqStudio to generate the ot.fs file, which contains I2C instructions (with data) on how to program
the OTP with the values that were just set up in RAM.

5. Use the ot.fs file with the SmartFlash programming tool; the OTP on the bq27220 device can be
programmed.

4.6 General Setup and Software Installation to Program OTP
1. Equipment needed:

(a) Lab power supply configured for 7.4-V output (expect approximately 5-mA maximum current)
(b) Battery or second power supply with ≥ 3.0-V output (expect approximately 1-mA maximum current)
(c) EV2300 (v3.1r or later) or EV2400 USB with I2C interface adapter
(d) Unprogrammed bq27220 device assembled in the battery pack or on the EVM
(e) Example .gg file provided by factory
(f) Battery Management Studio (bqStudio) software installer
(g) SmartFlash software executable

2. Install bqStudio software.
3. Connect the EV2300 or EV2400 to the unprogrammed device or EVM.
4. Connect the battery to BAT(+) and VSS(–) pins.
5. With output disabled, connect the lab power supply to GPOUT and VSS(–) pins.

NOTE: Do not apply 7.4 V to the device until prompted by software.

http://www.ti.com
http://www.go-dsp.com/forms/techdoc/doc_feedback.htm?litnum=SLUA771
http://www.ti.com/tool/GPCCEDV
http://www.ti.com
http://www.ti.com/lit/pdf/SLUUBF5
http://www.ti.com/tool/BQSTUDIO?keyMatch=bqstudio
http://www.ti.com/tool/BQSTUDIO?keyMatch=bqstudio
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4.7 Launch bqStudio Software
1. Launch bqStudio software.
2. Confirm Gauge Dashboard panel detects the EV2x00 adapter and the bq27220 device.
3. If the device has been previously SEALED, UNSEAL it by sending the appropriate keys to Control()

(0x00 and 0x01). The bq27220 boots up in UNSEAL mode, but not in FULL ACCESS mode. Enter
FULL ACCESS mode to gain access to the Data Memory.

4. Click Data Memory to show the OTP factory defaults that are in data memory (RAM).
5. Click Import to load Data Memory contents from the provided sample .gg file.

Figure 5. Launch bqStudio Software

4.8 Load .GG File
This procedure imports the fuel gauge data or the data memory image to the device.
1. Browse to a desired template or sample *.GG parameter file. (example: bq27220.gg.csv in Figure 6.)
2. Click the Open button.

http://www.ti.com
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Figure 6. Load .GG File

4.9 Confirm or Update Data Memory Parameters
Use the following list to confirm or update data memory parameters:
1. Imported Data Memory (RAM) parameters that differ from the factory defaults appear in orange font.
2. Confirm or update Data Memory (RAM) parameters as required.
3. Save .gg file for future reference by clicking Export.

http://www.ti.com
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Figure 7. Confirm or Update Data Memory Parameters

Figure 8. Update Battery ID

4. Set BATT_ID2 to 1.

http://www.ti.com
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4.10 Save .OTFS File
The following steps show how to save an .OTFS file
1. Click the GoldenImage icon.
2. From the GoldenImage panel, enter desired .OTFS base file name (example, bq27220.ot.fs).

NOTE: No Options changes are required.

3. Click Create Image File.
4. Exit bqStudio software.

NOTE: It is important to exit the bqStudio software because the EV2x00 adapter must be freed for
SmartFlash.

Figure 9. Save .OTFS File

4.11 Launch SmartFlash Software
Use the following steps when launching the SmartFlash software:
1. Launch SmartFlash software.
2. Confirm auto-detection of the EV2x00 adapter, gauge = 220 and version ≥ 1.09.
3. Click File → Open.

http://www.ti.com
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Figure 10. Launch SmartFlash Software

4.12 Open ot.fs File
1. From the pop-up dialog box, click the needed ot.fs file and click Open.
2. Confirm successful file load from log window.

Figure 11. Open .OTFS File

http://www.ti.com
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4.13 Program OTP
1. Click the Program button.
2. When the Apply Programming Voltage pop-up dialog box appears, enable 7.4-V power supply and

click OK.
3. After a brief delay (approximately 1-second) for OTP programming and when the Remove

Programming Voltage pop-up dialog box appears, disable the power supply and click OK.

Figure 12. Apply 7.4 V

Figure 13. Program OTP

4.14 Confirm Success
1. Confirm the message Programming completed successfully! from the log window.
2. The device is now fully programmed.

http://www.ti.com
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Figure 14. Confirm Success

http://www.ti.com
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